CCA- Fundamentals of IT & Programming

Assignment - 1

Q1. What are the four fundament parts of computer? Explain it with the help of diagram.

Ans.

Central Processing unit

Arithmetric/logic

\\

The four fundamental parts of computer are: \C

1.Input Devices: Computer systems use m es for input purpose. Input devices include the

mouse, input pen touch screen, microph rdIess of the type of device used, all are
components for interpretation and co jcation between people and computer systems.

2. Central Processing Unit (CPU): I@ brain of the computer without this unit computer unable to

process 2
3. Output device: Output is used to show the result of the instructions. Example Monitor,

The mem ores the binary information in the form of bits.

Printer, Headphon
4. Memory unit: A%ory unit is the collection of storage units or device together.

Q2. Discu out the classification of computer based on size and capacity.

@ed on size and capacity, computers are classified as

Super computers: They have thousands of process, Because of their extraordinary speed,
accuracy and processing power, supercomputers are well suited for solving highly complex
problems and huge amount of calculations.

E.g. JAGUAR, ROADRUNNER etc.

2) Mainframe computers: They are very large often filling an entire room and process thousands of
millions of instructions per second. They are capable of supporting hundreds to thousands of users
simultaneously. Functions performed by mainframes include flight scheduling, reservations and
ticketing for an airline etc.




3) minicomputers: They are much smaller than mainframes. They are typically larger, more powerful
and more expensive than desktop computers. Users connect to the server through a network by
using desktop computers.

e.g. apple | pod, CDC 160A.

4) Microcomputers: They are the most frequently used type of computers. It is also known as
personal computers.

e.g. Desktop computer, laptop.

Q3. What is the meaning of computer generation? How many computer generations are deﬂm&Q :
What technologies were/are used?

Ans. Generation in computer terminology is a change in technology of a computer wh@e being
used. There are four computer generation such as 15 generation, 2" generation, ration and

4" generation %
In the first computer generation system, vaccum tubes are used. 0

Transistors are used in the Second generation. Q\

Integrated circuit technology were used in the third generatk&%’
In the fourth generation microprocessors are used. \
S\es.

Q4. Differentiate between volatile and non- volatile m

Ans. Volatile memory | ;% Non- Volatile memory
NS
\

1. Itisatype of computer
memory that has the capability
to hold saved data even if the
power is turned off.

2. E.g. ROM, hard disk, floppy
disk, etc.

3. Secondary memory provides
permanent storage of data and
in bulk quantity.

1. Itis a computer storage that
only maintains its data while
the device is powered.

2. E.g.RAM.

3. Primary memory has limited
storage capacity and is
volatile.

Q>

Q5\DBi ﬂnguish among system software, application software and open software on the basis of
heirfeatures.

s. System software: Its is a type of software that is designed to run a computer’s hardware and
application programs. Software like operating systems, compilers, editors and drives etc. come
under this category. A computer cannot function without the presence of system software.

Q6. a) Create a file in MS-Word to insert a paragraph about yourself and save it with film name
“yourself”. Describe all step involved in it.



Ans. “Yourself” My name is Oinam Radharani Devi. | am 20 years old. . | am a student of Arts
stream at IMPHAL COLLEGE, IMPHAL,MANIPUR. Currently | am learning computer CCA course at RGI
TRAINING INSTITUTION.

The steps involved are;

» We click the Microsoft office button.
» We select new. The new documents dialog box appears.
» We select blank document under the blank and recent section. | will be highlighted by
default. QO
We click create. A new blank documents appear in the word window. \Q

To save the document, We click again the Microsoft office button.
We select save as == word document. The save as dialog box appears. ®
We select the location where we want to save the document using the drop menu.
We enter the file “yourself” for the document.

We click the save button. %
b) Write steps regarding followings. : @

YVVVYYVYYVY

» To change the font style

» To change the font size %-

» To change the font colour x‘

> To highlight (in yellow) the line that reads ”nee‘%&t S’s address”.
Ans. Steps to change the font style: 0

1. We select the text we want to modify. \C‘?

2. Left click the drop-down arrow nex@ nt style box on the home tab. The font style
drop-down menu appears.
3. We move cursor over the vari t styles. A live preview of the font will appear in the

document
4. Left click the style w Wfb se. The font style will change in the document.

Steps to change the font size

1. We select e want to modify.
2. Leftclickt own arrow next to the font size box on the home tab. The font size
drop n menu appears.
\/\Q ursor over the various font sizes. A live preview of the font size will appear on
ument.

ft click the font size we want to use. The font size will change in the document.

6 o change the font colour:

() . We select the text we want to modify.

Left click the drop-down arrows next to the font colour box on the home tab. The font

colour menu appears.

3. We move cursors on various font colours. A live preview of the colour will appear in the
document.

4. Left click the font colour we want used. The font colour will change in the document.

N

Steps to highlight the line:




1. We select the line that reads “needs to get IMS’s address”
2. We click the highlight command and select yellow colour un the font group on the home tab.

Q7. Create a file in MS- Word for the following document and save it with file name ‘ms-word’.
Describe all steps involved in it.

MS-Word

MS-Word is a widely used commercial word processor developed by Microsoft.

Ms-Word is application software, Which is capable of . QQO
e C(Creating, \

e Editing,

e Saving, ®

e Printing any type of document,
Ans. MS-Word %
MS — Word is a widely used commercial word processor developQ@osoft.
MS-Word is application software, which is capable of %.
N

e C(Creating

e Editiong \
Saving \
Printing any type of document 0

1. We click the Microsoft office bu@'
d

2. We select new. The new doc ialog box appears.

The steps involved are:

3. We select blank docume the blank and recent section. If will be highlighted by
default.

4. We click create. A 'bnk document appears in the word window.

5. We create the gj uments from the question.

6. We select h% “MS-Word” to change the font size by clicking on the font size box on
the home<€.

7. We 'ﬁ':.th text “MS-Word” to change the font colour into red by clicking on the font
rmenu.

8. lect the text word processor and underline it by clicking underline command in the
fort group the home tab.

» We select the text “MS-Word” to change the font style into italic by clicking italic

command.
() 10. We select the text we want to format as a list and click on the bullets command on the
home tab.

11. We change the font colour of the text “creating” and “saving” into blue and red resp. By
clicking on the font colour command, again we select the text “and” and click on
strikethrough command.

12. We select the text “printing any type of document” and change the font style into bold by
clicking on the font style command.



13. We save the file name as “ ms-word” by clicking the Microsoft office button and select save

as

14. We select the location where we want to save the document using drop-down menu
15. We click the save button.

Q8. Create a file in MS-Word for the following document and save it with file name ‘equation’.
Describe all steps involved in it.

Equations:
Xo+y>=30 . QQO
23+g*=50 ®\

Ans. Equations

artb®=xs+y; ®

X2 +ys5=30 \o%

23+ q* =50 Q
Ar+b® =xa + y° %'

The steps are: \
1. We create the given documents in MS-Word
2. We select the text where we want to format a@lick on the subscript and superscript
command on the home tab \
3. We save the file name as "equation% ing the Microsoft office button and select save
4.

5. We click the save button. @
Q9. Create a file in MS-Wor vert existing highlight text to table as show below and save it

as
We select the location where v@ to save the document using the drop down menu

as file name ‘text to table “. IQ Pe all steps involved in it.

Select the text you to‘¢Onyert.

Select the inse.rt<t4m

Click o Nﬁwmand. A dialog box appears.

Click

V4
Qf%an OK Finally Selected text convert in a table

C

ert text to table, a new dialog box appears here set number of columns.

Select the text convert you want to. Select the Insert tab.

Click on table command. A dialog box appears. Click on convert text to table, a new dialog box
appears.

Here set columns. Click on OK Finally Selected text convert in atable




Ans. To convert existing text to table:

vk wnN e

Ans.

We select the existing highlight text that we want to convert.

We select the insert tab

We click the table command

We select convert text to table form the menu. A dialog box appears
We click ok. Them the text appears in a table.

Q10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it.
° Q(:\;:)

&

o
/
(

The steps are:

We place our insertion point in the documeg’c\\@we want our table to appear

1.

2. We select the insert tab

3. We click the table command 0

4. We drag our mouse over the diagra\gﬁre to select the numbers of columns and rows
in the table
Left click our mouse and the t ears in the document.

6. We enter the text into the

Q11. Create a following workshee@‘—Excel and save it with name ‘book1’.

S

Roll No Nm Marks

1 « nl 60
N\
2 <<\, n2 70
3 r\". n3 80
4 b n4 90
5 7 ns 40
6 né 50
7 n7 77
8 n8 44
9 n9 88
10 nl0 55
Sum 654
average 65.5

maximum 90



Ans. Minimum 40

Q12. Calculate the following things of a range (c2:c11) of data in the worksheet created in question

no 10.

=  The sum of the marks using AutoSum in range of cells (c2:c11)
= Average of the marks in range of cells (c2:c11)

= Highest marks in range of cells (c2:c11)

=  Minimum marks in a range of cells (c2:c11)

Average 65.5 6\

Maximum 90

Ans. Minimum 40 f§°
Q13. a) Describe various steps involveQ&\ﬁ‘fe following

=  To modify column widt Q‘Worksheet
=  To modify the row h‘ htof a worksheet

=  To delete rows@ mns of a worksheet
Ans.

I.  Selectsco Qa range of columns.

II.  Select.a Home*ab and in the cells group, select format.
Il Clw dmn width and the width for column.
k

V. e .
- ,T%odify the row height of a worksheet.
Select a row or a range of rows.
® Select a Home tab and in the cells group, select format.
() Il. Click on Row height and Type the height for row.
IV.  Select OK

- To delete rows and columns of a worksheet.
l. Select the cell you want to delete within the column or row.

II.  Select Home tab. And in cell group click on Delete Sheet Column or Row.

OR
i Select the desire row or column.

Q13 b) Describe the following terms in the worksheet

&

Roll No. Name Marks
1 nl 60
2 n?2 70
3 n3 80 ®
4 na 90 fb
5 n5 40 \
6 né 50 o%
7 n7 77 \
8 n8 44 Q
9 no 88 %'
10 n 10 55 ,\
Sum 654



- Absolute reference and relative reference in formula.
- Cell address.

Ans.

- Absolute Reference:
An absolute reference in Excel means there is a fixed point of reference applied to a cell or a
formula. This is so the return value will always stay the same no matter where the cell or
formula moves to — within the same sheet or across different sheet.

constant in this situation).

o

- Relative Reference : \

It is the default cell reference in Excel. It is simply the co%ﬁion of column name and row
number without any dollar € sign. When you copy thegffor from one cell to another the
relative cell address changes depending on the relative'gosition of column and row. C1, D2,

E4, etc. are examples of relative cell reference tive references are used when we want
to perform a similar operation on multiple cells\ad the formula must change according to
the relative address of column and row.

This refers to a relative point of ref ’b,'is constantly change and dollar sign (€) is absent
in the formula (i.e., When each ice and quantity are difference variable, there’s no

constant in the calculation).®
- Cell Address: 6

A cell address is bination of column letter and a row number that identifies a cell on a

worksheek%
For example, A1 refers to the cell at the intersection of column A and row 1; B2 refers to the
se ellén the column B, and so on.
sed in formula, cell references help Excel find the values the formula should
c ate. For instance,

v .~ To pull the value of Al to another cell, you use this simple formula:
< =Al

< To add up the value in cells A1 and A2, you use this one:

Q14.a) What tools are available to customize our PowerPoint presention are:

=A1+A2

Ans.
Tools available to customize our Power Point presentation are:

a. Perspector



Pivot viewer

Autodesk 3DS Max

VisualBee Power Pointg Add-in
SmartArt

Animiations and Transition
Wordle

CA coo

Oomfo

j. Clip Champ

S@ -0 oo T
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b) Write the steps for the following action for the creation of power point presentation .\Q
- Open a Blank presentation ®
- Save the presentation as Lab1.pptx fb®
- Add aTitle to the first slide; the name of your college %
O

- Type your first name and last name in the Subtitle section Q\

- Add a New Slide which has a Title and Content
Ans. & e
- To open blank presentation; s\‘\

i Open PowerPoint presentation using ommand ( window key + R)
ii. Select the ‘Blank Presentation’. It is;opéned.
- Save the presentation on Labl.pptx; t‘)
I.  Select the ‘File’ on tab bar.

Il.  Click on ‘Save As’ option. \'
M. Click on document/Deskto%&r choice.
IV.  Type the name ’stl.p®
V.  Click the ‘Save’ hutten.
- Add aTitle to the fir %the name of your college.
l. Left click on k to add title’ section on the first slide.
f your college.

Il Typet r@
- Type your ndme and last name in the subtitle section:
L'{t Aick on the ‘Click to add Subtitle’ section.

®
ur first name and last name.
ew slide which has a Title and content.
elect the Home tab.

V& Click on the dropdown button of the ‘New Slide‘ on toolbar.

Q} . Select the side having ‘Title and Content’. It is a added.

(415. Write steps for creation of a set of PowerPoint slide that demonstrates your skill to use the
tools of PowerPoint. It should include the following things

Titles slide & bullet list
Inserting Excel Sheet
Clip art and text

Slide show effects

YV V VY
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> Title slide and bullet list:
I Open PowerPoint presentation.
Il.  Select the Home tab.
lll.  Click at the dropdown button on ‘New Slide’ at toolbar.
IV.  Select the slide having Title slide and Bullet list.
» Inserting Excel sheet:

I.  Open the slide where yiu want to insert the Excel sheet.
Il.  Select the ‘insert tab’. And click on ‘Object’ on toolbar. Q

®
Il. Select the ‘Microsoft Excel Worksheet’ object type. Q\

V. Click the ‘OK’ button.
> Clip Art and text: @
l. Selection the insert tab. (b
Il. Select the ‘Pictures’ or ‘Online Pictures’ on tool bar. \
Il. Choose the appropriate art for the topic. 0%

V. Click on the ‘insert’ button.

> Slide show effects: Q\

l. Select ‘Design Tab’ for themes,Variants and slide siz
1. Select ‘Transition Tab’ for cut, fade, push, wipe,& a

I, shape, Flash, etc. for slide
effects.

Q16. What is the difference Machine language and Higﬁ&&al Language?

Ans. Machine language High level language
1. A computer programming 1. Itis a programming language
language consisting of that enables development of a
binary instruction which a program much more user
computer can respond to friendly programming context.
directly. 2. It takes additional translation
2. It require no translator to time to translate the source
translate the code. It is code to machine code.
directly understood by the 3. The takes additional
computer. translation time to translate
3. This language makes fast the source code to machine
and efficient use of the code
N computer. 4. They are programmer friendly.
D 4

7. Discuss about different data types of C programming Language.
() Ans. The different data types in C programming language are:

Char: The most basic data type in C. It store a single character and requires a single bite of
memory in almost all compilers.

Int: As the name suggests, an Int variable is used to store an integer.

Float: It is used to store decimal numbers,
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Double: It is used to store decimal numbers (number with floating point value but of memory in
high in comparison to float)

Q18. Find the output of the following expressions.
a) X=20/5*2+30-5 b)Y=30-(40/10+6)+10 c)Z=40*2/10-2+10
Ans. a) X=33

b) Y=30
c) Z=16 %
° Q
Q19. Describe the syntax of the following statement. @\

a) If —else statement b) For loop c) White loop d) Do- while loop ®

Ans. a) If — else statement:
If statements can be followed by an optional else block of statements, w '@cutes when the
Boot can expression is false.

Syntax Q\
If (expression) &%"

{ S\\

True block of statements; Q

) S
>

else

&
{ Q
else block of statements; ®
b’b

}

For (expressi Jexpression 2; expression 3)

{

®
BIOfkﬁﬂytatement

In above syntx

b) Forloopis simiIz%hile loop. Basic syntax of loop is as follows:

#xpression 1- initialize variable
xpression 2- conditional expression as long as this condition is true, loop will keep

() executing.
Expression 3- itis the modifier which will increase or decrease the value of the variable.
c) While loop
Basic syntax of while loop is as follows
While (condition)
Single statements

OR while (condition)
{

Block of statements
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}

d) Do- while loop.
Do- while loop is just like a while loop except that text condition is checked at the end of the
loop rather thn the start. This has the effect that the body of the loop are always executed at
least once
Basic syntax of do- while loop is as follows.
Do

{

Single statements %
or <
} while ( condition ); @\

Q20. Find the output of the following program segments

o\
a) b) c)
#include <stdio.h> #include <stdio.h> #include <stdio.h>
Int main() Int main() Vold main()
{ { {
Int1; Int I=1; Int a=10, b=100;
For (i=1;1<2;1++) While ( 1<=2) If (a>b)
{ { Printf(“Largest number is
: . . . %\n”,a);
Printf(“IMS Ghaziabad\n”); Printf(“IMS Ghaziabad\n”);
else
} }
Printf(“Largest number is
} } %d\n”,b);
t

e X\}(\V
g
8



